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Introduction

The 2011 Tohoku earthquake tsunami brought great damages to human
lives, industries and economics in Japan, and provided an important lesson
for disaster reduction and evacuation. We have reconsidered the disaster
prevention policy and tried to renew multilateral regional disaster plans for
multiple scenarios of tsunami onsets. The estimation of regional tsunami
heights provide fundamental conditions to design the disaster plans; devel-
oping infrastructures, hazard maps and managing evacuation for various
scenarios. While reasonable tsunami computation to predict the tsunami
heights along coasts need to be performed, it requires technical knowledge
and experiences to operate computer simulators as well as expensive high-
performance computers. Whereas local government needs to make the local
disaster and evacuation plans to save the local resident against tsunamis, it
may be difficult for them to predict the heights by themselves because the
absence of human and computer resources, which may slow down procedures
of planning.

iRIC-ELIMO has been developed with a motto of ”simple and easy
tsunami computation” for people with minimum knowledge to operate Win-
dow softwares, which is capable of reliable estimations of tsunami generation,
propagation and evolution on coasts on easy-performable GUI environment
provided by iRIC.

ELIMO ver. 4 introduced a submarine mass failure model (Watts et
al. 2005) to nonlinear long wave equations to simulate tsunami induced
by submarine landslide, which allows simulataneous evaluation of tsunamis
caused by interplate earthquake and landslide.

Users should carefully confirm the following specifications of ELIMO
and understand the model assumptions and limits of the applications. Any
applications beyond the model conditions and computational accuracies used
in ELIMO are not supported. It should be noted that iRIC-ELIMO cannot
be held responsible for any disadvantages, loss, cost which may be incurred
by ELIMO. Confirm and agree Terms of Conditions before using ELIMO.
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ELIMO 4.0 Specification　 (June 2023)

1. Governing equation; nonlinear long wave equation

2. Coordinate system; Spherical global coordinate

3. Computational method; Euler-Lagrangian finite difference method with
third order accuracy (CIP metod + Predictor-Corrector method)

4. Bathymetry; General Bathymetric Chart of the Oceans (GEBCO) al-
titude data

5. Shore boundary condition; Impermeable condition at shore (no inun-
dation on land area)

6. Open boundary condition; Radiation condition + Sponge zone (addi-
tional energy dissipation)

7. Fault model; Elastic rectangular fault model (Okada 1985), Tsunami
generation model including horizontal fault displacements (Tanioka ad
Satake 1996).

8. Submarine mass failure model (Watts et al 2005)
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Update Records

1. July 2013　Release of ELIMO 1.0

2. November 2013　 ELIMO 1.1; Release a format conversion software
”gebco conv” for GEBCO 1 minuet altitude grid data that is down-
loadable from British Oceanographic Data Center. The user’s guide
updated.

3. June 2015 ELIMO 2.0; ”gebco2s2014” for 2014 format of GEBCO
data has been provided. The elastic rectangular fault model by Okada
(1985) and the tsunami generation model by Tanioka and Satake (1996)
have been introduced. The arbitrary fault models with asperities can
be used for the ELIMO computation by using a file input function for
the fault parameters.

4. 2019; Allowing direct input of NetCDF GEBCO data (without pre-
processing).

5. June 2023; Introducing a model for submarine landside tsunami.



Chapter 1

What is ELIMO?

A tsunami computation is a fundamental way to provide tsunami heights and
arrival times along coasts for past and future earthquakes, which has been
used for designing disaster prevention plans. The computations have been
generally performed at high performance computers owned by Universities
and research institutes, and commonly used by researchers and engineers
who have scientific knowledge and experience of the numerical computation.
There may be no computational tool that is accessible to the public. While
the disaster prevention and evacuation plans for tsunami inundation are
required to develop by local governments, they have no way to estimate the
tsunami properties by their own human and computational resources. Under
these background, we have tried to develop technologies for producing a
compact and reliable software to compute tsunami for arbitrary earthquake,
which is executable on home PC. We hope this tsunami software named
ELIMO will be utilized for estimating the tsunami onsets in order to achieve
disaster reduction and efficient evacuation.

iRIC is a computational platform to support computations of river flows
and floods with the pre-processing functions of computational griding and
the post-processing of visualizing and plotting the results on GUI environ-
ment. The tsunami solver ELIMO (Easy-performable Long-wave Inundation
MOdel) is designed to perform fundamental tsunami computations on the
iRIC environment.

This users guide for ELIMO is composed of three chapters. In Chap-
ter 1, governing equations to be solved, boundary conditions, assumptions
and numerical methods used in ELIMO are explained. While researchers
and engineers who have scientific knowledge should confirm these technical
interpretations, general users may skip this chapter. In Chapter 2, the pro-
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CHAPTER 1. WHAT IS ELIMO? 2

Figure 1.1: Spherical global coordinate system.

cedure to acquire bathymetry data, to compute tsunami and visualize the
results is explained. Chapter 3 introduces examples of the tsunami compu-
tations, including the 2011 Tohoku earthquake tsunami.

1.1 Governing equation

The depth-averaged long wave equation is used as governing equation in
ELIMO (Fig. 1.1).
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where the depth-averaged mean velocities u = 1
h+ζ

∫ ζ
−h u

′dz, v = 1
h+ζ

∫ ζ
−h v

′dz

(local velocities u′, v′), R is the distance from the center of the earth, Ω is
the earth’s rate of rotation，λ longitude, ϕ latitude, pa atmospheric pres-
sure, ζ surface elevation, νh coefficient of horizontal momentum exchange.
Mass conservation for the depth-averaged equation system is written by
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Imposing zero gage pressure at the surface and ignoring surface shear, the
above equations are rewritten with an additional dissipation term Ad in a
sponge zone (explained in the following section) by
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and τ bϕ = Cd|v|v. While many values for the drag coefficient Cd have been

proposed for specific flows, Cd = 5× 10−3 is used in ELIMO.
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Figure 1.2: Impermeable condition at a shore

1.2 Computational methods and boundary condi-
tions

The third order accurate, finite difference computations are performed for
the nonlinear equation system Eq. (1.4)-Eq. (1.6) in the same manner as
Watanabe et al. (2012); Constrained Interpolation Profile (CIP) method for
the advection equation in a two-step fractional step framework, predictor-
corrector method for the Eulerian terms. We don’t explain the details of
these numerical methods in this users guide, which can be found in the
specialized literature (Goto, Okayasu and Watanabe, 2013).

1.2.1 Impermeable condition at a shore

The current version of ELIMO simply uses an impermeable condition the
shore; that is, virtual vertical walls are arranged along the shore (Fig. 1.2).

The impermeable condition at a shore is expressed by

∂η

∂n
= 0 (1.7)

u · n = 0 (1.8)

where n is the normal unit vector (see Fig. 1.2).
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Figure 1.3: Computational domain and region to place the sponge zone
(Tokachi area, Hokkaido, Japan).

1.2.2 Open boundary condition

When a finite computational domain is given in ocean area, an open bound-
ary condition imposed at the edges of the domain is important to trans-
mit incident waves across the boundary without any reflection. A flawed
condition may induce unrealistic reflected waves at the boundaries to form
multiple reflection system within the domain, which results in unacceptable
computations. While a very large domain has been commonly used in the
conventional tsunami computation to avoid the difficulties, e.g. a whole area
of Pacific Ocean, ELIMO employs a compact domain to reduce computa-
tional loads. Therefore, appropriate open boundaries need to be given to
achieve an available computation in ELIMO. While any boundary condition
to achieve perfect transmission of incident waves has yet been developed,
Sommerfeld’s radiation condition has been commonly used (Orlanski, 1976);

∂φ

∂t
+ c

∂φ

∂n
= 0 (1.9)
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Figure 1.4: Amplification rate for the dissipation term in the sponge zone.

where the arbitrary quantity φ, and the celerity c approximated by the finite
difference at the previous time step;

c = −δφ

δt
/
δφ

δn
(1.10)

δ is the finite difference operator which is constrained by the conditions;

c =


0 (c < 0)
c (0 ≤ c ≤ ∆x/∆t)
∆x/∆t (c > ∆x/∆t)

(1.11)

Significant reflection may appear under this radiation condition in the case
that the celerity and incident angle spatially change near the boundary. In
order to attenuate the incident waves near the boundary and to minimize
the wave reflection, a so-called sponge zone is arranged at an inner area
adjacent to the boundary (see Fig. 1.3)．

According to Cruz et al. (1993), the dissipation coefficient Ad is given
by

Ad = Amax

√
g
h(N + 1)

(
i−imax+dlayer

dlayer

)N
if i ≥ imax − dlayer

Ad = 1 else
(1.12)

where N is the oder of the distribution function. N = 1 is used in ELIMO.
As shown in Fig. 1.4, Ad linearly increased in the sponge zone enhances
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Figure 1.5: Input window for computing conditions.

dissipation for Eq. (1.4) and Eq. (1.5). As additional reflected waves may
be produced within the sponge zone with too high gradients of Ad, suitable
(low) Ad should be provided in the computation. While a wider sponge
zone provides more dissipation, available computing area becomes smaller;
that is, there is tradeoff between computational cost and performance of
the boundary condition. User should carefully choose suitable number of
the computing cells comprising the sponge zone (dlayer) and the maximum
dissipation rate （Amax） in the window for computational conditions (see
Fig. 1.5). It should be noted that tsunami is wrongly computed in coastal
area containing the sponge zone as the computation is available except the
sponge zone (see circles in Fig. 1.3). In this case, you should change the
locations of the boundaries and use larger domain.

1.2.3 Initial Conditions

Fig. 1.6 shows the distribution of the vertical displacement of sea floor due
to the 2011 Tohoku earthquake tsunami, which provided by Japan Mete-
orological Agency. The vertical displacement of faults directly contribute
to sea level rise while the horizontal displacement also results in sea level
variations over uneven sea floors.

In general, deformation of the elastic rectangular fault is determined by
the fault parameters; Rupture length (L), Rupture width (W ), Slip length
(U), Rake angle (θ), Strike angle (ϕ), Dip angle (δ), Fault depth (d), Latitude
and Longitude of Fault Top（see Fig. 1.7 and Fig. 1.8）. ELIMO uses the
elastic fault model for the rectangular dip-slip deformation source, which
is derived by Okada (1985). This model provides the three-dimensional
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Figure 1.6: Displacement of sea floor due to the 2011 Tohoku earthquake
tsunami; vertical displacement (left) and horizontal one (right) (web page
of Japan Meteorological Agency).

displacements at arbitrary coordinate (x, y).
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Figure 1.7: Fault parameters; slip length, slip angle, strike and dip angle.
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and p = y cos δ + d sin δ, q = y sin δ − d cos δ, ỹ = η cos δ + q sin δ, d̃ =
η sin δ − q cos δ, R2 = ξ2 + η2 + q2 = ξ2 + ỹ2 + d̃2, X2 = ξ2 + q2, U2 is the
dip-slip displacement source. These displacements are evaluated by using
the following relation;

f(ξ, η) = f(x, p)− f(x, p−W )− f(x− L, p) + f(x− L, p−W ). (1.23)
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Figure 1.8: Fault parameters; longitude and latitude of the fault top, and
strike (in the case of the 2003 Tokachi-off earthquake)

Fig. 1.9 shows the vertical and horizontal displacements of the sea floor
for the fault parameters for the 2003 Tokachi off earthquake, estimated by
the Okada’s model. Any sea floor displacements for arbitrary fault param-
eters can be determined by this model.

Tanioka and Satake (1995) proposed the tsunami generation model to
use as an initial sea level condition (ζ), based on bulk water displacement
due to horizontal sea floor displacement as well as direct water displacement
by vertical sea floor displacement;

ζ = uz + ux
∂h

∂x
+ uy

∂h

∂y
(1.24)

ELIMO determines the initial sea level by the Tanioka-Satake model
using the Okada’s solutions for the input fault parameters. Users can choose
two options to input the parameters, ‘manual input’ and ‘file input’, on
ELIMO, and in particular, the latter option is useful for setting up spatially-
non-uniform displacements described by local deformation of multiple fault
segments, which will be explained in §2.2.2.
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Figure 1.9: Vertical (left) and horizontal (right) displacements for the 2003
Tokachi off earthquake.

1.2.4 Submarine landside

Watts et al. (2005) developed a Submarine Mass Failure (SMF) model,
defining initial sea-level displacement when submarine landslide occurs. Ac-
cording to their model, characteristic tsunami amplitude owing to the land-
slide is given by

η0 ≈ 1.74× 10−5b (1− 0.750 sin θ)

(
b sin θ

d

)1.75

(1.25)

where b is the length of SMF, d is the water depth at the maximum thickness
of initial SMF，θ is the bed slope．The initial surface form at arbitrary
location (x, y) was approximated by a double Gaussian distribution in x-
direction and a soliton-like wave form in y-direction with respect to the
initial location of SMF (x0, y0);

η(x, y) ≈ − η0
ηmin

sech2
(
κ
y − y0
w + λ0

)(
e
−
(

x−x0
λ0

)2

− κ′e
−
(

x−∆x−x0
λ0

)2)
(1.26)

where κ ≈ 3, w is the width of SMF, λ0 is the characteristic wavelength, κ′

and ∆x are parameters controling double Gaussian surface forms．ηmin indi-
cates the minimum value of the function on the right-hand side of Eq. (1.26)
(excluding the amplitude)．According to characteristic tsunami scalings,
characteristic time t0 = ut/a0, terminal speed ut =

√
gb
√
π (γ − 1) sin θ/2Cd,

initial acceleration a0 = g sin θ (γ − 1) / (γ + Cm), characteristic wavelength
λ0 = t0

√
gd．Here, γ is the specific gravity, Cd is the drag coefficient, Cm



CHAPTER 1. WHAT IS ELIMO? 12

Figure 1.10: An example of initial surface elevation estimated by Eq. (1.26)；
b=50m, d=5m, κ=3, ∆x=10m, w=25m, λ0=25m, κ′=0.8

is the added mass coefficient．The submarine landside tsunami can be sim-
ulated through computations of nonlinear long wave equations under the
initial surface elevation defined by Eq. (1.26) with these specific parame-
ters.



Chapter 2

Tutorial

This chapter describes a whole procedure to simulate and analyze tsunami;
acquisition of bathemetry data, import of the bathemetry file, generation
of computing grids, setup of initial conditions (fault rapture parameters,
computing conditions), execution of ELIMO, visualizing and analyzing com-
puted results.

2.1 Acquisition of bathymetry data

ELIMO 4.0 uses netCDF bathmetry data provided by General Bathymetric
Chart of the Oceans (GEBCO). As the GEBCO covers the whole area of the
earth, we can simulate tsunamis occurring anywhere in oceans. The data
can be downloaded in the following procedure;

1. In the web site of the General Bathymetric Chart of the Oceans
（GEBCO）https://www.gebco.net/, click ‘Download GEBCO’s global
grid’ （bule rectangure bottom on the top left in Fig. 2.1）．

2. Click the world map (Fig. 2.2) bellow ‘Download data for user-defined
areas’．

3. Fill in latitude and longitude of boundaries of the rectangular area to
download in ‘ENTER BOUNDARY’ on the left side of the world map,
or specify the rectangular area by dragging mouse with holding ‘Ctrl’.

4. In｀SELECT FORMATS’ (left input space), click a check box for 2D
netCDF and Grid (top left check box)．

13
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Figure 2.1: Web site of GEBCO

Figure 2.2: Specify a region to download
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Figure 2.3: Download the bathymetry data

5. Click ‘Add to basket’ (bottom button in left input space)．Then, click
the neighboring button ‘View basket’.

6. Click a right bottom button ‘Download your data’ on a popup window
(Fig. 2.3)．

7. Move the downloaded data to a folder used for your computation.
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Figure 2.4: Importing bathymetry data file

2.2 Operations on iRIC

The procedures to compute tsunami and visualize the results are explained
below.

2.2.1 Generation of computing grids

1. Run iRIC.

2. Choose ‘File’ → ‘New Project’. Choose ’ELIMO’ in the window ‘Select
Solver’.

3. Confirm ‘Pre-processing window’ is generated. Choose ‘Import’→‘Geographic
Data’→‘Elevation’.

4. Choose your downloaded GEBCO file (Fig. 2.4).

5. Click ‘OK’ on a popup window telling ‘To import the geographic data,
specify coordinate system for the project first’.

6. Type ‘wgs’ in a search work box on a popup window of ‘Select Coor-
dinate System’. You will then find ‘EPSG:4326:WGS 84’ in the list of
coordinates. Click this coordinate (see Fig. 2.5).
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Figure 2.5: Setting coordinates

7. Confirm the imported bathymetry is identical with the area you want
to compute.

8. Menu ‘Grid’→‘Select Algorithm to Create Grid’. Choose ‘Create grid
by dividing rectangular region (Longitude-Latitude)’ in the window
‘Select Grid Creating Algorithm’.

9. Define the computational domain by a mouse within the area of the
imported bathymetry (Fig. 2.6). Note that the computational domain
has to be smaller than the imported bathymetry area, and should be
inside any bathymetry data boundaries.

10. Choose ‘Grid’→‘Create Grid’. Define a grid width ‘d’ to be the resolu-
tion that you want to compute at. Since the global coordinate system
is used in ELIMO, x-axis represents longitude and y-axis is latitude
(i. e. d=0.1 degrees may indicate the grid width over 6 km). As com-
putational costs increase with the resolution, User should choose the
optimal grid width in terms of resolution and cost. The grid width d
to be in a range of 0.01 and 0.02 degrees (36 – 72 second) is recom-
mended. As GEBCO has the resolution of 15 sec, user can compute
at higher resolution, while there may be interference between the grid
locations of the bathmetry data and computing grids (especially near
shore lines). If you find strange computed results (such as strange
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Figure 2.6: Generating a computing domain

waves generated before arriving tsunami), reconsider the grid width d.

11. Click ‘OK’ on the popup window.

2.2.2 Setting computational conditions and Executing ELIMO

Menu ‘Calculation Condition’ → ‘Setting’, then appearing a window ‘Cal-
culation Condition’. Each group in the left box is explained bellow (Fig.
2.7).

File Input of Falut Rapture Conditions

If you answer for ”Which manner to input fault conditions?” is ”Manual In-
put”, you should manually input fault parameters for interplate earthquake
tsunami. If you select ”File Input”, click the button on the right of ”File
Name of Fault Conditions” and select your parameter file on the dialog box.

Fault Rapture Conditions (Manual)

This method is useful to manually input the parameters for one or two
rectangular faults on the input window of ELIMO. For instance, the two
faults models for the 2011 Tohoku earthquake tsunami have been proposed
by the Geospatial Information Authority of Japan (Table 3.1). To provide
multiple fault displacements following this model, fill in parameters on the
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Figure 2.7: Window of Calculation Condition

Table 2.1: Rectangle fault model for the 2011 Tohoku earthquake with
following parameters provided by the Geospatial Information Authority of
Japan

latitude latitude length width slip length strike dip rake Fault depth
(o) (o) (km) (km) (m) (o) (o) (o) ( km)

Fault 1 39.00 143.49 199 85 27.7 202 18 97 10.0
Fault 2 37.21 142.51 176 82 5.9 201 15 81 10.1

first fault in ‘First Fault Rupture Conditions’ and parameters on the second
one in ‘Second Fault Rupture Conditions’. Default parameters for the 2003
Tokachi-off earthquake tsunami have been provided. For any fault model
with a single rapture, all parameters for ‘Second Fault Rapture Conditions’
should be given to be zero. It should be noted that ‘Fault depth’ is defined
by depth of the fault bottom d in ELMO (see Fig. 1.7) while depth at the
fault top dtop may be used in some fault models for scenario tsunami. d can
be estimated with dtop by

d = dtop +W tan δ sin θ (2.1)

where δ is the dip angle，W is the rapture width and θ is the rake angle.

File input of the fault parameters

Fault models for past and scenario tsunami, commonly provided, are com-
posed by many fault segments to describe asperity and local orientation of
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Figure 2.8: Input window for fault parameters

the raptures (Fig. 2.9). In ELIMO, arbitrary fault parameters for multiple
segments can be given by a batch file input. For instance, if the parame-
ters for 12 segments described in Fig. 2.9 are provided by Table 2.2 (These
parameters will be explained again in §4), as shown in Fig. 2.10, the pa-
rameters for each segment are described on each line in order of latitude,
longitude, rapture length, rapture width, slip-length, strike, dip, rake and
fault depth with space or comma separation. It should be noted that ‘Fault
depth’ is defined by depth of the fault bottom d in ELMO (see Fig. 1.7). If
depth at the fault top dtop is defined in past fault models, d estimated by
Eq. (2.1) needs to be provided in the file. Add lines for the parameters of
all segments; in the case of Fig. 2.9, every parameters of 12 lines should be
written and saved with arbitrary file name.

Submarine Mass Failure Conditions (Manual)

Parameter input for submarine landslide tsunami using SMF model is ex-
plained bellow.

For ”Which tsunami to compute?”, select ”Plate Boundary Earthquake
Tsunami Only”, ”Submarine Landslide Tsunami Only”, or ”Both”. Input
the following parameter (see section 1.2.4);

1. ”Longitude of SMF center (deg)”

2. ”Latitude of SMF center (deg)”
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Figure 2.9: Fault segments of the scenario tsunami of Hokkaido off earth-
quake.

3. ”Latitude of SMF center (deg)”

4. ”Length of SMF along seabed slope (km)”; b

5. ”Width of SMF (km)”;w

6. ”Characteristic wavelength; lambda0 (km)”; λ0

7. ”Parameter Kappa’”; parameter controlling double Gaussian distribu-
tion κ′（ratio of positive and negative initial surface displacements in
Fig. 1.10）

8. ”Parameter Delta x (km)”; shape parameter of double Gaussian dis-
tribution ∆x (km)

Here depth of initial SMF d and bed slope θ are automatically estimated
from the bathymetry data. κ=3 is given as constant.

Computing Conditions

Input the maximum time step number, time-step interval for saving output
files (e.g. if 3 is given, the data files are saved every 3 time steps) , number
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longitude latitude length width slip length strike dip rake depth (fault top)
(o) (o) (km) (km) (m) (o) (o) (o) ( km)

Fault 1 147.5584 42.4135 70.0 70.0 35.0 235 10 90 5.0
Fault 2 146.8476 42.0703 70.0 70.0 35.0 235 10 90 5.0
Fault 3 146.1445 41.7226 70.0 70.0 35.0 235 10 90 5.0
Fault 4 145.4488 41.3704 70.0 70.0 35.0 235 10 90 5.0
Fault 5 144.7606 41.0140 70.0 70.0 35.0 225 10 90 5.0
Fault 6 144.1726 40.5693 70.0 70.0 35.0 225 10 90 5.0
Fault 7 147.0946 42.9421 70.0 70.0 30.0 235 20 90 17.0
Fault 8 146.3802 42.5962 70.0 70.0 30.0 235 20 90 17.0
Fault 9 145.6735 42.2457 70.0 70.0 30.0 235 20 90 17.0
Fault 10 144.9746 41.8907 70.0 70.0 30.0 235 20 90 17.0
Fault 11 144.1716 41.4608 70.0 70.0 30.0 225 20 90 17.0
Fault 12 143.5836 41.0132 70.0 70.0 30.0 225 20 90 17.0

Table 2.2: Fault parameters for the segments of the scenario tsunami of
Hokkaido off earthquake (corresponding to Fig. 2.9).

of grids contained in a sponge zone (dlayer in §1.2.2), and the maximum
dissipation rate in a sponge zone (Amax in §1.2.2). dlayer and Amax may be
adjusted if unacceptable reflection occurs at the open boundaries (depending
on size and location of the computing domain).

Confirming the computing conditions

Click ‘OK’ on the window of ‘Calculation Condition’.

2.2.3 Run computation

Menu ‘Simulation’ → ‘Run’．Duration from the tsunami generation is dis-
played on a console screen.

2.2.4 Visualizing the results

How to visualize the results is explained in iRIC Users Manual; such as con-
tours, vector plots, animation of the results. In this chapter, only particular
operations required in ELIMO are explained.

1. ‘Calculation Result’ → ‘Open new 2-D Post-Prosessing Window’

2. Click a check box of ‘SElevation’ in ‘Elimo Grids’¿‘iRIVZone’¿‘Scalar’
on Object Browser (Fig. 2.11)．
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Figure 2.10: Parameter text file for the file input.

3. Right click on ‘SElevation’ and select ‘Property’ to set up graphycs
(color bar, color range and so on)．

4. When you choose one on the list of ‘Background Images (Internet)’ on
Object Browser, your result is superposed on the selected map (Fig.
2.11)．

5. Sequential images of the computed results every output time step are
displayed if you operate in menu ‘Animation’．
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Figure 2.11: Visualized surface elevation 「SElevation」



Chapter 3

Examiples of Computations

3.1 The 2011 Tohoku earthquake tsunami

Figure 3.1: Propagation of the 2011 Tohoku tsunami (10 min interval from
tsunami generation)．

The Geospatial Information Authority of Japan provided the rectangle
fault model for the 2011 Tohoku earthquake with following parameters. In
this model, the depth of fault is defined at the top of fault. The fault depths,
defined at the bottom in ELIMO, are estimated by Eq. (2.1) to be 37.4 km

25
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latitude latitude length width slip length strike dip rake Fault depth
(o) (o) (km) (km) (m) (o) (o) (o) ( km)

Fault 1 39.00 143.49 199 85 27.7 202 18 97 10.0
Fault 2 37.21 142.51 176 82 5.9 201 15 81 10.1

and 31.8 km. Therefore, the estimated depths, 37.4 and 31.8, need to be
described on ‘First and Second Rapture Condistions’ instead of 10.0 and
10.1 in Table 3.1. As many fault models using the depth of fault top have
been proposed, Use should confirm the definition of the parameter used in
the model.

Fig. 3.1 shows the contours of the surface elevation of the tsunami until
one hour after the earthquake. It is seen that the tsunami radically spreads
at an early stage, arrives to Iwate prefecture at 10 – 15 minutes, Hokkaido
and Kita-Kanto areas after one hour. These computed arrival of the tsunami
are consistent with the observed ones.

3.2 Comparisons with the observed surface eleva-
tion

Kawai et al. (2013) reported the surface elevation of the 2011 Tohoku
tsunami measured by GPS buoys installed Tohoku off. Fig. 3.2 shows the
observed surface elevations presenting rapid evolution of the tsunami wave
shapes.

Fig. 3.3 shows the initial stage of the computed surface elevations at
the corresponding locations to the GPS stations. We find overall features of
the computed tsunami evolution are consistent with the observed ones de-
spite that the simplest rectangular fault model are used in the computation.
Improvement of accuracy is expected by introducing polished fault models
with asperity.

3.3 Submarine landslide tsunami

M 7.5 earthquake occurred on Sulawesi, Indnesia o the 28th of September,
2018. Tsunami has been observed around coast of Palu Bay after 30 min
later the earthquake. The analyses of this tsunami conclude submarine
landslides induced by the earthquake generated the tsunami (Nakata et al.
2020).

While there have been many studies on magnitude and area of landslide,
as an application of SMF model, the computed tsunami based on a scenario
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Figure 3.2: Observed surface elevations at the GPS tide stations (After
Kawai et al. 2013)．

that a submarine landslide occurred off Palu is shown here.
Fig. 3.4 shows evolution of the submarine landslide tsunami. While

resolution of bathymetry data is not enough to compute local tsunami near
the coast, overall features of the propagation with reflection in the bay can
be found from the results.

3.4 Scenario tsunami

Many fault models for scenario tsunamis, expected to occur in future, have
been proposed by the governments and research institutes, which provides
possible tsunami heights along coasts of Japan. Most models composed of
multiple fault segments can be used on ELIMO by the function of the batch
file input.
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Figure 3.3: Computed surface elevations at the GPS tide stations.

The government of Hokkaido, Japan, defined the scenario tsunami that
may cause the maximum inundation on Pacific coasts of Hokkaido, and
provided the fault model. In this model for the extreme tsunami, 12 fault
segments with the parameters in Table 3.1 are assumed to adjacently locate
as shown in Fig. 3.5.

The text parameter file for Table 3.1 are shown in Fig. 3.6. The line
number corresponds to the fault number. The parameters for each seg-
ment,latitude, longitude, rapture length, rapture width, slip-length, strike,
dip, rake and fault depth with space or comma separation, are described
on each line. As already explained, ‘Fault depth’ is defined by depth of the
fault bottom d in ELMO (see Fig. 1.7). If depth at the fault top dtop is
defined in past fault models, d estimated by Eq. (3.1) needs to be provided
in the file.

d = dtop +W tan δ sin θ (3.1)

where δ is the dip angle，W is the rapture width and θ is the rake angle.
For example, for Fault 1 – 6, 5+70×tan(10×π/180)×sin(90×π/180) ≈

17.3, and for 7 -12, 17 + 70 × tan(20 × π/180) × sin(90 × π/180) ≈ 42.5
should be written in the file as ‘Fault depth’ instead of 5.0 and 17.0. Every
parameters of 12 lines are written and saved with arbitrary file name for the
batch input.
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Figure 3.4: Sea level changes owing to the 2018 Palu tsunami, Sulawesi,
Indonesia (5 min interval)

Fig. 3.7 shows the evolution of the Hokkaido scenario tsunami generated
by the model of Table 3.1 . The tsunami, generated by the fault displace-
ments over a wide area, radically propagates and reach to the Pacific coasts
after 10 – 20 minutes. The first wave of tsunami arrives at most coasts of
Hokkaido and Tohoku after 30 minutes, and formations of edge waves are
confirmed after 50 minutes.

Fig. 3.8 presents the computed surface elevations (not by ELIMO) re-
ported by the government of Hokkaido. We find the analogous features of
tsunami elevations to Fig. 3.7.

I this way, ELIMO can simulate arbitrary tsunami generated by any
model without any limitation of number of segments.
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Figure 3.5: Fault segments of the scenario tsunami of Hokkaido off earth-
quake.

longitude latitude length width slip length strike dip rake depth (fault top)
(o) (o) (km) (km) (m) (o) (o) (o) ( km)

Fault 1 147.5584 42.4135 70.0 70.0 35.0 235 10 90 5.0
Fault 2 146.8476 42.0703 70.0 70.0 35.0 235 10 90 5.0
Fault 3 146.1445 41.7226 70.0 70.0 35.0 235 10 90 5.0
Fault 4 145.4488 41.3704 70.0 70.0 35.0 235 10 90 5.0
Fault 5 144.7606 41.0140 70.0 70.0 35.0 225 10 90 5.0
Fault 6 144.1726 40.5693 70.0 70.0 35.0 225 10 90 5.0
Fault 7 147.0946 42.9421 70.0 70.0 30.0 235 20 90 17.0
Fault 8 146.3802 42.5962 70.0 70.0 30.0 235 20 90 17.0
Fault 9 145.6735 42.2457 70.0 70.0 30.0 235 20 90 17.0
Fault 10 144.9746 41.8907 70.0 70.0 30.0 235 20 90 17.0
Fault 11 144.1716 41.4608 70.0 70.0 30.0 225 20 90 17.0
Fault 12 143.5836 41.0132 70.0 70.0 30.0 225 20 90 17.0

Table 3.1: Fault parameters for the segments of the scenario tsunami of
Hokkaido off earthquake (corresponding to Fig. 2.9).
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Figure 3.6: Parameter text file for the file input.

Figure 3.7: The surface elevations along Hokkaido coasts by Hokkaido sce-
nario tsunami, computed by ELIMO (10 minutes intervals).
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Figure 3.8: The surface elevations along Hokkaido coasts by Hokkaido sce-
nario tsunami, reported by the local government of Hokkaido.



Conculding Remarks

Large earthquakes exceeding M8 are expected in near future, such as Tokai,
Nankai trough and Nemuro-off earthquakes. Multiple approaches for reduc-
ing tsunami disaster and minimizing damage expected for such earthquake
should be considered in a rush. We hope ELIMO that enables general users
to perform the tsunami computation supports developments of these ap-
proaches and improve education for disaster prevention.

June, 2023
ELIMO development team
Yasunori Watanabe (Hokkaido University)
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